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Instantis EnterpriseTrack What's New 

 

Key enhancements in Instantis EnterpriseTrack release 8.5 include: 

 Resource calendars 

 Labor expense types for activity labor cost capitalization 

 Variable resource rates     

 Enter resource allocation hours in bulk 

 Project request improvements  

 Timesheet improvements 

 Improved listing pages 

 Field change history 

 UPK enablement 

 Finance lock 

 Additional performance and user experience improvements 
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Resource Management 

Resource management enhancements in Instantis EnterpriseTrack release 8.5 include:   

 Resource calendars 

 Labor expense types for activity labor cost capitalization 

 Variable resource rates 

 Enter resource allocation hours in bulk 

Resource Calendars 

New in Instantis EnterpriseTrack 8.5 are resource calendars, which allow exceptions to be specified 

for individual resources. Exceptions are used to enter variations to a resource's schedule, such as:  

 Vacation time  

 Long leaves of absence 

 Seasonal hours (For example, a resource works 45 hours per week in fall, winter, and spring, 

but only 30 hours per week in summer.)  

 Work on holidays or other non-work days (For example, the company normally has off on 

Memorial Day, but some resources need to work that day.) 

Resource calendars can affect project schedules. Exceptions entered on resource calendars are 

reflected in resource capacity, heat maps, and reporting, allowing project managers to have 

precise capacity visibility.  

Each resource calendar is based on a reference calendar, as set by an administrator or project 

manager. When exceptions are added to the reference calendar, they are automatically applied 

to all derivative resource calendars.  

With the proper permission, resource calendars can be modified as follows: 

 Edit My Resource Calendar permission: Add exceptions to and remove exceptions from 

your own resource calendar.  

 View All Resource Calendars permission: View a team member's resource calendar.  

 Edit All Resource Calendars permission: Add exceptions to and remove exceptions from a 

resource's resource calendar. You can also change a resource's normal work hours and 

work days, providing support for part-time workers.  

Resource calendars also provide support for one-way syncing with Microsoft Project. 
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Benefits:  

 Enhanced, reliable project planning 

 Precise capacity visibility for improved resource planning 

Location:    

 To view your own resource calendar: On the My EnterpriseTrack menu, click My Calendar.  

 To view a team member's resource calendar: On a Project menu, click Go To, Resources, 

Listing. Select a resource, and then, on the Actions menu, click Select. The Details page is 

displayed. Click the Calendar tab. 
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Labor Expense Types for Activity Labor Cost Capitalization 

Project managers can use the Labor Expense Type column in Instantis EnterpriseTrack 8.5 to specify 

whether WBS activities are operational or capital expenses. The selected labor expense type 

determines the finance category (capital or operational) to which an activity's labor cost roll up.  

Multiple labor expense types can be created based on project needs. A default labor expense 

type can be selected in the Activity Template. Settings at the project level allow administrators to: 

 Enable or disable activity labor cost capitalization. 

 Indicate if project managers are required to select a labor expense type for each activity. 

 Set a default labor expense type for the project. 

 

Benefits:  

 Ensure proper cost accounting compliance. 

 Financial governance processes can be easily and accurately followed by project teams. 

Location: 

 On the Project Plan (Roadmap) page, select a labor expense type by clicking a cell in the 

Labor Expense Type column.  

 For project-level labor expense type settings, on the project menu, click Go To, Settings, and 

scroll down to the Activity Labor Cost Capitalization section. 
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Variable Resource Rates 

Instantis EnterpriseTrack 8.5 introduces variable rates that are specific to individual resources. Each 

resource's labor rates can be set to change over time -- for example, a resource's rate is $42 per 

hour through August 31 but changes to $43.50 per hour on September 1. Changing a resource's 

rate affects all projects to which that resource is assigned.  

Instantis EnterpriseTrack 8.5 also introduces variable role rates. Like resource rates, role rates can be 

set to change over time. For example, the rate for a QA Tester is $70 per hour in the current fiscal 

year but increases to $72 in the next fiscal year. Changing a role's rate affects the standard role 

rate for all resources who have that role.  

When staffing projects, project managers have the option of selecting the role rate, or the rate 

specific to the individual resource.  Starting with EnterpriseTrack 8.5, project managers can also 

override resource or role rates at the project level. 

 

Benefits: 

 Better project cost estimation and tracking 

 More flexible costing methods and easy cost administration 

Location: 

 Each resource's rates can be seen on the resource's rate list table. 

 To locate a resource's rate list table: From a Project Resources page, click Edit on the 

resource's Actions menu.  
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 To locate a resource's rate list table: From the Resource Listing page, click Edit, Rates on the 

resource's Actions menu. 
 

Enter Resource Allocation Hours in Bulk 

Instantis EnterpriseTrack 8.5 adds a plan effort total option for resource allocation. When assigning 

a role or resource to a project or project request, select Plan Effort Total if you want to assign the 

role or resource for a bulk number of hours.  

For example, while staffing an Application Development project, you can now assign (a resource) 

Dan Jenkins, a software engineer, to contribute 150 hours over the course of the entire project, or 

within the confines of specific dates.  

Previously, you could only assign roles or resources using percentage utilization (Dan needs to 

spend 25% of his time on the Application Development project.), or plan effort (Dan needs to work 

on the Application Development project for 15 hours per week for the first seven weeks, for 25 

hours during week eight, and for 20 hours during week nine.)  

 

Benefit: 

Faster, more flexible resource assignment 

Location: 

Specify the number of hours you want the resource or role to contribute in the Plan Effort Total field 

on the Add Team Member page. 
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Project Request and Project Create 

Project request and project create enhancements in Instantis EnterpriseTrack release 8.5 include: 

 Project request process improvements 

 Quick project create with custom fields 

 Help configurability enhancements 

Project Request Improvements 

Instantis EnterpriseTrack 8.5 makes multiple improvements to the project request process. Project 

managers can now:  

 Add roles by clicking Add Role.  

 Add the same role multiple times.  

 Remove non-mandatory roles. 

 Quickly check resource availability. 

Other enhancements: 

 Fields used during finance plan creation have been simplified to reflect first-level finance 

categories. This applies to finance fields in all areas of EnterpriseTrack (project requests, 

projects, what-if, reports, etc.).   

 When a resource request is submitted for a project request, the resource manager, while 

approving the request, can specify the labor rate type (resource rate or role rate).  
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Benefits:  

 Improve productivity by creating the right project staffing plans, project approvals, and 

performing resource capacity analysis. 

 Perform improved financial analysis. 

Location: 

Navigate to the Create New Charter/Proposal page. On the Create menu, click Proposal, and 

then scroll down to the Initial Project Team Members section.  
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Quick Project Create with Custom Fields 

In Instantis EnterpriseTrack 8.5, the quick project creation process prompts users to enter project 

custom fields (changed from project request custom fields in 8.0).  

Additionally, custom fields carry over from project request to project, as was the case in Instantis 

EnterpriseTrack 8.0.  

 

Benefits: 

Improved project creation 

Location: 

On the Create menu, click Project, and scroll to the Project Custom Fields section. 
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Help Configurability Enhancements 

Instantis EnterpriseTrack 8.5 introduces the ability to configure Help content accessed in: 

 Idea Details and Idea Evaluation 

 Proposal Evaluation (at initiative level) 

 Proposal/Project Fields (at initiative level) 

Administrators can keep Help content as-is or customize it by attaching a Help document (Word, 

Excel, HTML, PDF, etc.) or by pointing to a URL (internet, intranet, SharePoint, wiki, etc.). 

 

Benefit: 

Maintenance cost savings 

Location: 

Click Administration. In the Settings section, click Manage Help. 
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Reporting Improvements 

Reporting improvements in Instantis EnterpriseTrack release 8.5 include:   

 New program filters 

 Improved listing pages 

 New Heat Map by Resource CSV report 

 Support for Microsoft Excel 2010 
 

New Program Filters 

Starting with Instantis EnterpriseTrack 8.5, you can filter by a program manager or one or more 

programs when viewing the following: 

 Project Listing page  

 Project Bubble chart (filter plus a dimension in X or Y axis) 

 All heat map reports 

 Activity Detail report (Excel) 

 Timesheet Detail report (Excel) 

In order to use program filters, programs must first be created and have projects linked to them in 

EnterpriseTrack's Program module. 
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Benefit:  

Improved program management analysis 

Location: 

On the Manage Reports page, click the Run with Filters icon next to a report that supports program 

filters. Program filters are displayed on the Filters tab in the Details pane. 
 

Improved Listing Pages 

Instantis EnterpriseTrack 8.5 introduces several changes to listing pages that improve searching and 

page performance.  

Searching 

 Column selection and arrangement are saved when searches are saved (including group 

by and pivot).  

 Idea listing pages now feature saved searches.  

Performance 

 Pages have been optimized for quicker load times. 

 Pages return warning messages when search results exceed the cache limit. 

 Columns that could degrade performance are indicated with an icon.  
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Benefits: 

 Better system response time and admin/user control 

 Improved user experience 

Location: 

 To save column selection and arrangement with a saved search, configure columns and 

then on the Advanced Search page, save the search and its criteria.  

 To see the icon indicating which columns could have a negative effect on system 

performance, click the Select Columns icon.  
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Additional Reporting Improvements 

Instantis EnterpriseTrack 8.5 introduces a Heat Map by Resource CSV report, which allows for 

output as a non-interactive CSV (comma-separated value) file.  

Additionally, Microsoft Excel 2010 is now supported, allowing for improved data compression when 

running large user-defined reports.  

 

Benefits: 

 Additional report output option 

 Better support for large data volume when running user-defined reports.  

Location: 

On the Go To menu, click Reports. The Heat Map by Resource CSV report is located in the Detail 

Reports folder under Resource Reports. 
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Usability and Performance Improvements 

Usability and performance improvements in Instantis EnterpriseTrack release 8.5 include:   

 More compact heat maps 

 Improved resource planning page 

 Improved application cache 

 Quicker navigation to project issues, risks, defects, backlogs, and scope change requests 

 More uniform interface 

 Oracle User Productivity Kit enablement 

Performance Improvements 

Instantis EnterpriseTrack 8.5 introduces a number of changes to enhance performance:  

 More compact heat maps: User can hide rows containing zero values, thereby improving 

performance when running reports against longer projects.  

 Resource Planning page changes: The Resource Planning page now features a new 

monthly mode. Also, computations are made in-server for better performance.  

 Improved application cache: EnterpriseTrack's application cache architecture has been 

improved for better performance. 

Benefits: 

 Better system response time 

 Improved user experience 
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  

User Experience Improvements 

Starting with Instantis EnterpriseTrack 8.5, users can easily navigate to issues, risks, defects, backlogs, 

and scope change requests from project-specific menus. 

Additionally, non-WBS pages now have the same spreadsheet-like interface as WBS pages.  
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Benefit: 

Improved user experience 

Location: 

On a Project menu, click Create, and then select an option.  
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UPK Enablement 

Starting with release 8.5, Instantis EnterpriseTrack is enabled for Oracle User Productivity Kit (UPK), 

an Oracle application that enables users to develop, customize, and publish documentation and 

e-learning content.  

Instantis EnterpriseTrack's UPK enablement allows users to access EnterpriseTrack-specific UPK 

content from the Help menu. It also allows organizations to purchase pre-built UPK content 

developed specifically for EnterpriseTrack and/or develop their own content.  

UPK is a separately licensed product which may have to be installed on-premise (including SaaS 

customers).  

 

Benefits: 

 Increased user competency 

 Reduced user training and support costs 

Location: 

 On the Help menu, click User Productivity Kit to access your organization's UPK content.  

 Click Administration, Manage User Productivity Kit to view or edit the location of your 

organization's UPK content. 
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Other Improvements 

Other improvements in Instantis EnterpriseTrack release 8.5 include:   

 Timesheet improvements 

 Field change history 

 Finance lock 

Timesheet Improvements 

Instantis EnterpriseTrack 8.5 timesheets optionally support Estimated Time to Completion (ETC) and 

Expected Remaining Effort (ERE).  

 ETC: Prediction of time needed to complete a resource's portion of an activity, entered by 

the resource 

 ERE: Calculated by EnterpriseTrack as plan effort minus actual effort 

The addition of ETC allows resources to provide higher quality activity status updates.  ETC entered 

on timesheets rolls up to activity level upon timesheet approval.  

A warning indicator appears when ETC is not the same as ERE, allowing project managers to 

reconcile discrepancies between the two. Additionally, ETC can be enabled or disabled for 

specific projects.  

In addition to the introduction of ETC, EnterpriseTrack 8.5 adds the following timesheet features: 

 Project managers can change the grace period for timesheet reporting at the project level; 

they can specify how many days before the activity start date, and how many days past 

the activity completion date team members can continue to report effort in timesheets.  

 Resource timesheets are more compact; only activities that are eligible for reporting are 

displayed in timesheets. 
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Benefits: 

 Enhanced project execution through better understanding and reporting of time-related 

information 

 Enhanced user productivity via a simple and more intuitive user interface 

Location: 

 On the Go To menu, click Timesheets. With the proper configuration, timesheets contain 

Estimated Time to Complete fields. 

 On the Administration page, click Manage Estimated Time to Complete for Timesheet 

Settings to manage ETC settings at the initiative level. 

 On a Project Settings page, click Edit next to Timesheets to manage ETC settings at the 

project level. 

Field Change History 

Instantis EnterpriseTrack 8.5 retains field change history :  

 Who changed the value 

 When the value was changed 

 The old and new value 

 Comments (for approvals) 

 Context (description) 
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Change history is available for the following fields:  

Project Requests 

 Basics: Status, Roadmap 

 Finance: Initial fields (varies depending on finance template configuration), Cost of Capital, 

Tax Rate, Cost of Asset 

 Dates: Planned Start Date, Actual Start Date, Planned Project Close Date 

 Approvals: Signoff Status 

Projects 

 Basics: Status, Roadmap 

 WBS and non-WBS: Name, Status, Resources, Plan Start, Plan Completion, Actual Start, 

Actual Effort, Actual Completion, % Completion 

 Dates: Current Start Date, Actual Start Date, Planned Project Close Date 

 

Benefit:  

Improved auditing and change visibility  

Location: 

On a project menu, click Go To, Field Change History, or, click Field Change History in the left-hand 

navigation.  

  



Instantis EnterpriseTrack What's New 

 
 

26 

 

 

Finance Lock 

Instantis EnterpriseTrack 8.5 offers two new enforcement modes for finance lock/close periods: 

 Strict mode: Finance lock/close period is strictly enforced. No changes to labor rates or 

currency conversion rates are allowed in locked/closed financial periods. For WBS activities, 

AET (Actual Effort Type) is restricted to Effort at Resource Level (Detail), Effort from Timesheet, 

and Effort from Finances. 

 Limited mode: Finance lock/close period enforcement is manual (not automatic by system). 

This behavior is very similar to that found in Instantis EnterpriseTrack 8.0.  

The following table lists the supported options for both modes: 

  Strict Mode Limited Mode 

Enforcement Always guaranteed. 

Guaranteed only when used with AET 
set to Effort from Finances, finances 
are edited in Monthly mode, and 
resource rates are explicitly overridden 
at the project level. Enforcement is 
through manual process. 

Resource, Role, and 
Labor Rate Changes 

Not allowed if it can affect a finance 
lock/closed period in any project. 

System does not check for violation, 
and finance/lock close period integrity 
not protected. 

Currency Conversion 
Rate (Exchange Rate) 
Changes 

Not allowed if it can affect a finance 
lock/closed period in any project. 

System does not check for violation, 
and finance/lock close period integrity 
not protected. 

Supported AETs 
Effort from Timesheets, Effort at 
Resource Level (Detail), and Effort from 
Finances. 

All AETs. 

Unsupported AETs 

Duration & Resource % Availability, 
Effort at Activity Level - Equal % 
Distribution, Effort at Activity Level- 
Unequal % Distribution, and Effort at 
Resource Level (Summary). 

None. 

Editing Finances in 
Yearly or Aggregate 
(Annualized) Mode 

Not allowed to protect finance lock / 
close period integrity. 

Allowed. Finance lock / close period 
integrity not protected. 

Changing the enforcement mode in a live, production environment is not recommended. When 

the mode is changed, it affects only new projects. Existing projects remain in the previous 

enforcement mode and cannot be changed.  
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Benefit: 

Enforce corporate financial reporting governance. 

Location: 

Administrators can view or change enforcement modes. On the Go To menu, click Administration. 

In the Settings section, click Manage Finance Lock/Close Period Enforcement Settings. The Finance 

Lock/Close Period Enforcement Settings page is displayed.  
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Changes and Deprecations 

Changes and deprecations in Instantis EnterpriseTrack release 8.5 include:   

 Simplified idea portal landing page 

 Several newly supported and several deprecated or no longer supported items 

Simplified Idea Portal Landing Page 

The Idea Portal allows individuals without EnterpriseTrack login credentials to input ideas into the 

application. In Instantis EnterpriseTrack 8.5, the Idea Portal has been simplified to allow only for idea 

submission and search. It is not possible to access projects or project requests from the portal.  

Benefit: 

Improved license and security enforcement. Users without proper privileges do not have a 

backdoor entry for viewing project details. 

Location: 

The Idea Portal is accessed via a separate URL supplied by your organization.  

Support and Deprecation Updates 

Instantis EnterpriseTrack 8.5 adds support for the following:  

 Microsoft Project 2010 

 Microsoft Excel 2010 

 Microsoft PowerPoint 2010 

 Mac OS 10.6.8 

 Mozilla Firefox 19 

Starting with Instantis EnterpriseTrack 8.5, Microsoft Internet Explorer 6 and older editions of Mozilla 

Firefox are no longer supported.  

SQL Server database is deprecated but is still supported in EnterpriseTrack 8.5; it may not be 

supported in future releases. This applies to on-premise customers only.  

EnterpriseTrack's Vista skin is also deprecated; users are encouraged to use the default 

EnterpriseTrack skin.  

For a complete list of compatibilities, please refer to the configuration information document for 

Instantis EnterpriseTrack 8.5 

(http://docs.oracle.com/cd/E41201_01/English/Tested_Configurations/EnterpriseTrack_Tested_Co

nfigurations.xlsx).  

http://docs.oracle.com/cd/E41201_01/English/Tested_Configurations/EnterpriseTrack_Tested_Configurations.xlsx
http://docs.oracle.com/cd/E41201_01/English/Tested_Configurations/EnterpriseTrack_Tested_Configurations.xlsx
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